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Ziel

R Ubersicht iiber das SDK
3 Wo bekomme ich es?
3 Wie funktioniert es?
3 Was ist enthalten?
& Debugging
3 Was bietet das SDK zum Debuggen?

3 Wie tiberpriife ich die Performance meins Programms?
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Installation

R Download von
http://developer.android.com/sdk/index.html

R Entpacken (Irgendwo)

3 android-sdk-<Plattform>
R android-sdk-linux

&R JDK iiberpriifen (>= 5)
R android-sdk-<Plattform>/tools zu PATH hinzufiigen
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http://developer.android.com/sdk/index.html
http://developer.android.com/sdk/index.html

Installation: Windows

LY Systemsteverung b System und Sicherheit » System Computemame | Hardware | Erweted Camxuwx"ﬂme

Berutzervariablen fiir Raid

S mussen als Administrator angemeldet sein, um disse Andenungen
durchfuhren au kornen Varable
Letstung

Startseite der Systemsteuerung : p . " = A

Basisinformationen (iber den Computer anzeigen

< PATH

% Gerate-Manager Windows-Edition Visuelle Effeide. Prozessorzetplanung, Speichemutzung und wiuelier TEMP
e Speicher

p
%' Remoteeinstellungen ™

Windows 7 Professional Einstelungen,.

% Computerschutz Copyright © 2009 Microsoft Carporation. Alle Rechte vorbehalten

% Enweiterte Systemeinstellungen o e en Edition von Windows shen Berutzemprofie
Deskiopenstelungen bezugich der Anmeidung
Systemvariablen
Variable

ComSpec
Qaten und Wisderherstelen

EP_NO_HOST €
System Systemstant, Systemfehler und Debuginfomationsn NUMBER_OF P...

0s
Klassdikation: ¢ Systembewertung ist nicht verfugbar

Prozessor: Intel(R) Core(TM)2 CPU 6600 @ 240GHz 239 GHz

Instalhierter Arbestsspeicher 4,00 GB (2,94 GB verwendbar)
(RAM)

Systemtyp: 32 Bit-Betriebssystem

Stift- und Fingereingabe:  Fur diesen Bildschirm ist keine Stift- oder Fingereingabe verfugbar.

Einstellungen fur Computernamen, Domane und Arbeitsgruppe
Computemame: Raid-PC I ins Name der Variablen:

Vollstandiger Raid-PC

& Wert der Variablen:
Computemame:

(ompulnb:‘.:hvtltunq:

Arbettsgruppe: WORKGROUP
Wartungscenter Windows-Aktivierung
Nindows Updat )
Whecious tpcate Windows ist aktivient.
Lesstungsinformats nd
:M'h”" el Produkt-I0: 00371-838-1462285-85143

Wert

C:'\Program Fles\Nmap;C: \Program File....
S ISERPROF: \ippData\LocalTemp
SUSERPROFILE % \AppData Local Temp

Wert
C:\Windows\system32\cmd. exe
NO

2

Windows N

PATH

{\bin;E: Pesktop \android-sdk-windows \took




Installation: Linux

R In /home/<Benutzer>
3 ~/.bash_profile oder ~/.bashrc indern
3 Nach PATH suchen

R Oder selber machen: export

PATH=${PATH}:<dein_sdk_Pfad>/tools
©3 tools/ hinzufiigen

R 32bit Kompatibilitit sicherstellen
©3 Ubuntu z.B. apt-get install ia32-libs
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Installation: IDE

R Android macht's mit allen
3 (auch Emacs)

&R Am besten: Eclipse
©3 Eigenes Plugin von Google

R Kontrolle des Emulators/Device
R Syntaxvervollstindigung
xR Etc.
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Installation: IDE

R ADT fir Eclipse
@3 Neu: 0.9.6 — Mirz 2010
©3 Help -> New Software
3 https://dl-ssl.google.com/android/eclipse/

R Bei Problemen http nutzen

R Pfad zum SDK
3 Window -> Preferences -> Android -> SDK Location
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Android Plattformen
(3

R Erstellen von AVDs
R API-Level aussuchen

3 z.Z. Android 2.1 Eclair Er

Available Packages [ AVD Name Target Name Platform API Level E
:::S‘Bs ~ my_avd Google APIs (Google Inc.) 21 7

3 Dokumentation e e B

3 Updates

3 Beispiele

©3 API Addons I =
® z.B. Google APIs

X An Android Virtual Device that failed to load. Click ‘Details’ to see the error.
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Erstellen eines AVDs

R Tool: android oder GUI

$ android create avd -n <Name> -t <targetID>

R Welche Targets?

$ android list targets
Available Android targets:
id:1
Name: Android 1.1
Type: platform
API level: 2
Skins: HVGA (default), HVGA-L, HVGA-P, QVGA-L, QVGA-P
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Erstellen eines AVDs

¥y Android SDK and AVD Manage

Virtual D
| |Installed Packages
Available Packages
Settings
About

List of existing Android Virtual Devices:

AVD Name Target Name

~ my_avd

API Level
Google APIs (Google Inc.)
o test

. 7
Google APIs (GoogleInc.) 7

~ Awalid Android Virtual Device.

¥ An Android Virtual Device that failed to load. Click 'Details’ to see the error.

MNarne: Android Plattform fir Mobile Gerite
Target: ’ VI
SD Card:
@ Size: MIE -
) File: | | | Browse... |
Skin:
@ Built-in: -
) Resolution: | x| |
Hardware:

Property

Value
Delete

[ ]Force create

X AVD name 'Android Plattform fir Mobile Gerdte' contains invalid cl
Allowed characters are; a-z A-Z0-9 . _ -

Create AVD H Cancel ]
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Erstellen eines AVDs

R Moglichkeit Skins zu benutzen
3 Nexus One Skin:

5 5554test

@ » android-sdk-windows » platforms » android-21 » skins » NEXUSONE v |4
‘ Organisieren ¥ In Bibliothek aufnehmen v Freigeben fir » Diashow Brennen Neuer Ordner
| } i Favorten « Datei (1)
i layout
3 Bibliotheken Datei
1,58 KB

|
|
i
§

=2 =S

& Heimnetzgruppe
8 Computer

€ Netzwerk

14 Elemente

4 Konfigurationseinstellungen (1)

% hardwareini
Konfigurationseinstellungen
86 Bytes

4 PNG-Bild (12)

back_sel png
PNG-Bild
1,02k8

background_port.png
PNG-Bild

704 KB

Copy of background_port.png

PNG-Bild
202KB

land_back sel.png
PNG-Bild
985 Bytes

land_menu_sel.png
PNG-Bild
1,08 KB

menu_sel.png
PNG-Bild

background_land.png
PNG-Bild
4 KB

Copy of background_land.png
PNG-Bild
211 KB

home_selpng
PNG-Bild
114KB

land_home_sel.png
PNG-Bild
114KB

. land_search_selpng

search_sel.png
PNG-Bild




Projekt erstellen

$ android create project \
--target <target_ID>\
--name <dein_Projekt_name> \
--path /pfad/zu/deinem/Projekt\
--activity <dein_activity_Name> \
--package <dein_package_Namensraum:>

R Update

$ android update project
$ android update project --name <Mein_Programm>
--target 8 — path <PfadZumProjekt>
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Projekt erstellen

R In Eclipse:
3 File->New->Other->Android->Android Project

E MNew

Select a wizard

T e

Wizards:

| type filter text

& Class

& Interface
22 Java Project
#% Java Project from Existing Ant Buildfile
@ Plug-in Project
= General
= Android
|@ Android Project |
Jﬁ' Android Test Project
dF Android XML File
= Connection Profiles

= CV5

@ Net> || Finsh ||

New Android Project
@ Project name must be specified

T

(| Project name: |

Contents
@ Create new project in workspace
() Create project from existing source

Use default location

() Create project from existing sample

Location: | E:/workspace | Browse...

Samples: | Please select o target.

Build Target

Target Name Vendor Platform
Android 21 Android Open Seurce Project 21
Google APIs GoogleInc. 21

APL...
7
7

Properties

Application name:

Package name:

Create Activity:

Min SDK Version:

@ <Back || Nea> [ Finish |

Cancel
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Anwendung starten

$ adb install /Pfad/zu/deinem/Programm.apk

3 Installiert die Anwendung im Emulator

3 Aus dem normalen ,,App-Menii” starten
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Anwendung starten

R In Eclipse:

R Rechtsklick auf Projekt:

3 Anwendung startet automatisch

@] Run Configurati

Android Application

Create. manage, and run configurations

Run As->Run Configuration

| B -~

type filter text

4 @ Android Application
| € HelloAndroid |
J Android JUnit Test
B Apache Tomeat
& Eclipse Application
E4 Eclipse Data Tools

Name: HelloAndroid

=] Android

Target . =] Common|

) Manual

wutomatic

Deployment Target Selection Mode

Select a preferred Android Virtual Device for deployment:

AVD Name Target Name Platform AP Level Details...
[ Generic Server
B Generic Server(Bxternal L ] my_avd Google APIs (Goegle Inc.) 21 7 E—
E HTTP Preview test Google APIs (Goegle Inc.) 21 7
[ J2EE Preview
=] Java Applet
©» [ Java Application
> Ju JUnit
Ji JUnit Plug-in Test
@ OSGi Framework
Juy Task Context Test
¢ XSL Emulator launch parameters:
Network Speed:
Network Latency:
i ———— [ aesy ] [ Reven
Filter matched 29 of 29 items
@ [ R ][ clese |

20/60



SD-Karte erstellen

R Wenn nicht beim Erstellen des AVDs geschehen
R Virtuelle SD-Karte
$ mksdcard -1 <Label> <Grofle>[K|M] <Datei>

3 FAT32

@ SIDISIE — Seraeai)
R SDXC — Vielleicht irgendwann

R Mount

$ emulator -sdcard <Datei> -avd <VirtuellesDevice>
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Skalierbares Ul

&R WYSIWYG oder XML
R Rudimentires Drag & Drop
&R XML vergleichbar mit XAML oder XHTML

] Java - HelloAnd oid/res/layout/main.cmi - Eclipse

n|a(E)

File

wE

[m g

Search

BrO-a-

Edit Run Project Window Help

EHE-

Refactor Navigate

[ A=0 d

;=

£0 Team Synchr...
=8
(omose] v 1]

& o
I

[J) Cubewallpapert java

A *mainaml £

Editing config: default

DeviceJ ADPL_~ [Config Landscape cl = Locale| = [ Theme
+ + +

Find

= Layouts ®

| AbsoluteLayout
(D) DialerFilter

(E) ExpandableList...
(¥ FrameLayout
Gnd\éew

= Views
Wrchecsox

(© CheckedTextVi
(© Chronometer
(D DatePicker
@) DigitalClock

O it Tt
Layout | main.cml

= Console | = Properties 53 & Progress

[21 Problems | @ Javadoc | [ Declaration

Property
DatePicker

Add states from children
Always drawn with cache
Animation cache
Background
Clickable
Clip children
Clip to padding
Content description
Descendant focusability

Value

DOMS (i3 Database De... (& Java | % Debug

:=]

Task List i0

2 Uncategorized

82 Outline 2

rameLayout0] (FrameLayout)
(D) DatePicke01 (DatePicker)

SVN Reposit... & JavaSimon
=8
f-%-IxB%(4°

b AL} Activate...

+=[t3[e7"0

| 23/60
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Skalierbares Ul

R Draw9

3 WISIWYG Editor fiir NinePatch Grafiken
&R NinePatch -> skalierbare Ul Elemente auf PNG basis
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Aufbau des Uls
(3

R Hierarchy Viewer

3 GUT =Tools
R Zugriff auf den Emulator

&R Ermoglicht Layout View und Display View bzw.
Pixel Perfect View

&) W=

File View Hierarchy Server

Devices Windows

<Focused Window >
com.android.internal.service. wallpaper. ImageWallpaper
com.android. contacts/com.android. contacts. DialtactsActivity
com.android.launcher jcom.android. launcher Launcher
com.android. calculator 2fcom. android. calculator 2. Calculator
TrackingView

StatusBarExpanded

StatusBar

Keyguard
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Aufbau des Uls
(3

PhoneWindow§Decorview
SO@43c26730
NO_ID

R Eigenschaften der ausgewihlten Elemente &t

isopaque()

R Layout View = =
3 3 Ansichten = :j"

®R ,, Tree View" e %:w s E
&R Hierachisches Diagramm der Ansicht i‘imm :E
R ,,Properties View" == %

, Wire-frame View*
R Skizze des Uls

FrameLayout FrameLayout

--------

! iMi:o NO_N 26/60




Aufbau des Uls

R Pixel Perfect View
3 3 Ansichten

R ,Explorer View" zeigt die Elementhierarchie als Liste

R ,Normal View" zeigt die normale Ansicht des Gerits

R Zeigt die Grenzen der einzelnen Ul-Elemente an

R ,Loupe View" zeigt die selbe Ansicht pixelgenau
3 Moglichkeit Bilder als ,,Overlay® zu laden
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Automatische UI Analyse

R layoutopt
3 Analysiert die dem UI zugrundeliegenden XML-Dateien

3 Testet das UI gegen einen Regelsatz
R Findet Mingel und gibt Ratschlige

$ layoutopt samples /
samples/compound.xml
7:23 The root-level <FrameLayout/> can be replaced with <merge>
11:21 This LinearLayout layout or its FrameLayout parent is useless
samples/simple.xml
7:7 The root-level <Framelayout/> can be replaced with <merge>
samples/too_deep.xml
-1:-1 This layout has too many nested layouts: 13 levels, it should have <=10
28:81 This LinearLayout layout or its LinearLayout parent is useless 28/60
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Syslog Anzeigen

R Traceview: Grafische Anzeige des Logs

//startet tracing nach ,,/sdcard/cal.trace” //stop tracing

Debug.startMethod Tracing(,,calc®); Debug.stopMethodTracing();

3 SD-Karten Image notwendig

3 Datei herunterladen
R adb pull /sdcard/calc.trace <Pfad>

3 Datei anzeigen

R traceview <Pfad>
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Syslog Anzeigen

[19] Thread-2
[15] Binder Thread #3 |

[13] Binder Thread #2| |

R Profile Pane
R Zeit in Methoden

&R Inclusive

&® Mit Subfunktionen
R Exclusie

&R Nur die Methode

e o6 Traceview: sdhome_js.
msec: 2,812.408 max msec: 26,635.108
5 000 15 000 20 000 IZS,OOO
orver] h————
[17] Thread-0. | IIIIII I (- [ 11 | I TR

R Zeigt das ausfihren
von Threads

Name
w [l 4 android/webkit/LoadListener.nativeFinished OV
3 android /webkit/LoadListener.tearDown (V
0 6 android /view/View.invalidate (DY
Ml 57 android fwebkit/BrowserFrame. startLoadingResource (ILjava
53 java/util/HashMap.put (Ljava/lang/Object;Ljava/lang/Objec
1 20 android /webkit/)WebCoreJavaBridge.setsharedTimer ()V
378 android /view/ViewGroup.requestLayout OV
0 315 java/util/HashMap. <init> (W
629 android /webkit/BrowserFrame.loadCompleted (QV
598 android jwebkit/WebView.didFirstLayout (V
[l 703 android /webkit/BrowserFrame.windowObjectCleared ()V
» | 5 android /webkit/)WebCoreJavaBridge$S TimerHandler.handleMessa
» W6 android/view/ View.invalidate (lIV
» _ 7 android/webkit/]WebCoreJavaBridge.access5300 (Landroid /webk
» 0 8 android /webkit/JWebCoreJavaBridge.sharedTimerFired OV
» B 9 android /view,View.invalidate (Landroid/graphics/Rect;)V
» _ 10 android/view/ViewGroup.invalidateChild (Landroid /view/View;La
» 0 11 android/event/EventLoop. processPendingEvents OV
b | 12 android /view/ViewRoot.handleMessage (Landroid /os/Message;)
» B 13 android /view/ViewRoot.performTraversals OV
» 0 14 android/view/ViewRcot.draw (Z)V
» [ 15 android/policy/PhoneWindows DecorView.drawT raversal (Landrc
» N 16 android/widget/FrameLayout.drawTraversal (Landroid /graphics,
» I 17 android /view/ View.drawTraversal (Landroid /graphics /Canvas;Le
» [l 18 android /view,ViewGroup.dispatchDrawTraversal {Landroid fgrap
b || 19 android /view,ViewGroup.drawChild (Landroid jgraphics/Canvas;
» N 20 android Timer )V
»L21 andrmd/webkll/WabV\ew nalweDrawRecl (Landroid /graphics/Ce
» 022 android/net/hup/QueuedRequest.start (Landroid /net/htip/Quel
» _ 23 android/net/http/QueuedRequestSQREventHandler.endData OV
» 0 24 android /net/http/QueuedRequest.setupRequest (V.
» B 25 android/net/http/QueuedRequest.requestComplete OV
» _ 26 android/webkit/CookieManager.getCookie (Landroid /content/Cc
» 0 27 android /webkit/LoadListener.commitLoad OV
b | 28 android /webkit/LoadListener.nativeAddData ([BI)V
» [l 29 android /graphics /Rect.offset (I}V

Incl % Inclusive Excl%  Exclusive Calls+Rec
66.6%17734.382 53.2%14161.950 14+0 P
100.0%17734.382 14/14 m
19.8% 3516.410 2413/2853

0.3% 44.636 3/15

0.0% 6.223 6/326

0.0% 2.593 2/730

0.0% 1.139 2/54

0.0% 0.879 3/41

0.0% 0.285 1/1

0.0% 0.231 1/2

0.0% 0.036 1/2
16.3% 4342.697 0.5% 132.018 730+0
15.6% 4161.341 1.2% 319.164 2853+0
15.1% 4025.658 0.1% 26.727 729+0
15.0% 3998.931 8.5% 2256.801 729+0
13.8% 3671.342 0.9% 246.190 285340
12.4% 3298.987 6.3% 1687.629 876+1148

6.3% 1674.317 0.6% 151.201 12+0

4.6% 1217.210 0.0% 1.992 35+0

4.5% 1209.815 0.0% 7.190 3440

4.1% 1096.832 0.0% 11.508 3440

3.9% 1040.408 0.0% 2.218 3440

3.8% 1023.77%9 0.0% 3.129  34+48

3.8% 1022.611 0.1% 19.213 34+154

3.8% 1000.413 0.2% 42.609 34+130

3.7% 983.346 0.2% 42.926 34+150

3.5% 929.506 0.2% 57.241 73040

3.5% 923.805 3.0% B807.952 15+0

3.2% 847.172 0.0% 3.556 15+0

3.1% 828.592 0.0% 1.619 15+0

3.1% 819.888 0.0% 5.860 15+0

3.1% 816.585 0.0% 1.506 15+0

2.7% 722.837 0.0% 8.081 15+0

2.6% GBB8.168 0.1% 17.708  58+0 -

2.3% 621.864 1.2% 306.817 57+0 k4

2.2% 573.985 2.2% 573.985 17210+0 b

Find:
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Syslog Anzeigen

R dmtracedump

3 Erzeugt ein Graphen, der den Aufrufstack reprisentiert

&R Benotigt Graphviz

| [1] androi/osHand ler.dispatc

| 31 android/view/ViewRoot handleMessage (145.0.4) | | 2]

r

| [4] android/view/ViewRoot. perform Traversals (143, 0, 2) |

r

7.0, 1) | [19] androidfvicw/V ic

wRoot.draw (71, 0, 2} |

| L] s

r

onMeasure (57, 0. 1) | | [20] android/widget/FrameLayout.draw (67. 0. 1) | | [71

r

e (57,0, 1) | [21] android/view/V iew.draw (67, 0, 1) |
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The Monkey

R Stresstest des Uls

R Erzeugt zufillige Ereignisse
3 Klicks

3 Berithrungen
3 Gesten

3 Systemereignisse

R Ereignisstyp einschrinkbar
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The Monkey

R Bearbeitet von einem Package

$ adb shell monkey -p dein.package.Name -v 500

R Stoppt bei Fehlern
©3 Unbehandelten Exceptions
©3 Crash
O3, application not responding“ Error
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Android Debug Bridge

R Abkiirzung: adb

R Vielseitig
3 Debugging
3 Dateniibertragung
3 Shell zugrift

R Besteht aus Client, Server und Daemon
3 PC: Client, Server

3 Emulator oder Device: Daemon
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Android Debug Bridge

R Adb Server lauft auf Port 5037

R Emulator / Device auf Port 5555-5585 (ungeraden)
3 Android Console auf den geraden Ports (Port — 1)

&R adb braucht beide
R Client-Server Struktur

R Normal: ein Rechner; ausbaufihig

3 einfache Kommunikation

3 Bei mehreren Adb-Daemons :

R Gibt Liste der Daemons aus

$ adb devices
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Android Debug Bridge

3

Emulator 1

Daemon

Emulator 2
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Android Debug Bridge

® Kann Programme installieren
$ adb install <Datei>

® Kann mit mehreren Daemons umgehen

$ adb -s emulator-5556 install <Datei>

R Moglichkeit zum Port Forwarding
$ adb forward tep:6100 tcp:7100

R Dateniibertragung
$ adb push / adb pull
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Android Debug Bridge

R Logdatei anzeigen

$ adb logcat <Filter>

R Bugreport erstellen

$ adb bugreport

3 Gibt kompletten Geritestatus aus

&R Kombination aus:
R Logcat
&® Dumpsys
R Dumpsate
@3 Emulator ohne laufende Programme 1,32MB an Text
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Android Debug Bridge

R Logcat
3 Zeigt System Debug Informationen an
R Filter
3 V — Verbose (niedrigste Prioritat: alles wird ausgegeben)
©3 D - Debug
3 | - Info
3 W - Warning
3 E - Error
3 F - Fatal
@3 S — Silent (hochste Prioritit: nichts wird ausgegeben)
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Android Debug Bridge

R Logcat Filter:

$ adb logcat Activity:Level
$ adb logcat ActivityManager:1 *:S

R Info zu ActivitcyManager
R Silent zu Rest

R Logcat Format:
3 -v <eineOption>

R brief, process, tag, thread, raw, time, long
R Logcat andere Logs
3 Radio, events, main (default)
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Android Debug Bridge

R Shell
$ adb shell

R Binirdateien in /system/bin

©3 Einige *nix Tools vorhanden

$ adb shell top /reboot / dd / mount /...
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Android Debug Bridge

R Sqlite3 Database
$ adb shell sqlite3

R .help fir Hilfe

R Grundlegende SQL Syntax
i@ rcateitable

3 Insert
3 SELECT FROM WHERE
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Dalvik Debug Monitor

R Anzeige des Heaps und Stacks
R Schrittbasiertes Debugging mit Breakpoints
&R Ubersicht iiber Garbage Collection

R Moglichkeit das Gerit ,,anzurufen”®
3 Oder SMS

3 GPS Position bereitstellen

&R Manuell (default ist irgentwo vor Afrika ©)
R Per GPX oder KML Datei
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Dalvik Debug Monitor

. DalvikE
File Edtt Actons Device Help
saoE2 o [info_| Thresds | VM Hesp | Allocation Trackes | Sysinfo | Emulator Control | Event Log|
Narme [Memery usage. =] [Losd from Fie  [Updatefrom Device
@ emulator-5554 Online test (21, .. PSSinkB

system_process 52
com,android.inputme 92
android.process.acorn 97
com.android.phone 94
comandroid.alarmcic 136
android.process.medi 152
com.android.email 163
com.googleprocess.s 211
System_process 222
com.android.develop 209
com.android.settings 584

a0
g

*if- QOOOO B H
7 1
Time pid  tag Message

3-12 01014, W il MadiaPlayes I0Exception; jave ioJOE
03-1201:014.. E 31 MedisP.. error -2
031201004, E 52 MediaP.. Unabletoto create media player
1 ;
12001014 W nputhd Window already focused, ignonng
03-1201:004., E 31 MedisP..,  ermor -2
031201:014.. E 52 MedisP.. Unableto to create media player

yd MediePlayes IOEsception: java.io

03-1201:014.. E 31 MedisP... erron -2

0312001:014.. E 52 MediaP.. Unabletoto create media player
1201004 ! d MedisPlayer I0Exception: javm.i0.10F

031201:004.. E 31 MediaP.. emor -2

03-1201:014., E S2 MedisP.., Unable to to creste media player

i MedisPlayes I0Exception: jo

io IOk

=
1201:014.,, W Bockuy saChanged but srticipant phg= .
03-1201:015.. D 152 dstvikvm  GC freed 273 objects / 10760 bytes in 1...
031201:01:5.. D 211 datvikvm  GC freed 40 objects / 1416 bytes in 80ms
03-1201:02 222 delvikvm  GC freed 478 objects / 23504 bytes in 9. -

Filter:




Dalvik Debug Monitor

File Edit Run Source Mevigate Search Project Refactor

Window Help

BiBFE H-0-QUr & F-

i}
¥

AR IE- 1

R SRR CR =

=3 (13 Database De.. & Java %5 Debug &

0 Team Sync >

o

% Thmadsf Heap % @ File Euplmﬂ

Name
4 B emulator-555 Online test[21, ..
system_pr 52 8500
com.andrc 98 8601
com.andre 36 8602
android.pr 101 8603
com.andre 119 8604
com.andre 146 8609
android.pr 162 8613
com.andre 181 8618
com.goog 195 8620
com.andre 212 8622
com.andre 235 8623
com.svox. 244 8624
ik com.exam 272 8621 /8700

=g

Heap updates are NOT ENABLED for this client

D HeapSze Allocated Free
Display: [Stats -
Type Count

% Used

Total Size

# Objects

Smallest

Cause GC

Largest

Median  Average

(& Emulator Control 53 =8
Telephony Status 2
Voice: Speed: Allocation count per size
A R
(L]
Telephony Actions B 08
Incoming number: )
a7
@ Voice
SMs =06
Message: A S5
04
il 03
02
Call | [ Hang Up
01
Location Controls w0
Manual | GPX | KML - Size
a LogCat 32 PEOOEE |+ ~|

Log

Tins pid  tag
03-12 01:43 D 272

Hessage

ddn-heap Heap GC request

03-12 01:43 D 272 dalwikvm threadid=3: still suspended after D
03-12 01:43... D 272 dalvikvm GC fzesd 587 chiects - 46416 byte. r
Filter:

ik Launching HelloAndroid
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Dalvik Debug Monitor

File Edit Run Source Navigate Search Project Refactor Window Help
03~ B B BNdi~-0-Ar @0 F PIApE@UD ST~
%% Debug 52 % 0w
o Thread [<3> main] (: at line11 in - Value
HelloAndroid.onCreate(Bundle) line: 11 a @ this HelloAndroid (id=830084772488)

Instrumentation. callActivityOnCreate(Activity, Bundle) line: 1047 » & ACCESSIBILTTY SERVICE “accessibility” (1d=830002519480)

ActivityThread performLaunchActivity(Activity Thread$ActivityRecord, Intent) line: 2459 & ACCOUNT_SERVICE “account’ (id=B30002513864)
ActivityThread.handleLaunchActivity(ActivityThreadSActivityRecord, Intent) line: 2512 & ACTIVITY SERVICE “activity" (1d=830002513036)

ActivityThread accessS2200(Activity Thread, ActivityThreadSActivityRecerd, Intent) line: 119 & ALARM_SERVICE “alarm” (id=830002514008)

ActivityThreadSH.handleMessage{Message) line: 1863 & APPWIDGET SERVICE “appwidget” (id=830002514072)

ActivityThreadSH(Handler).dispatchMessage(Message) line: 99 & AUDIO_SERVICE "audio” (id=330002514144)

Looperloop() line: 123 & BACKUP_SERVICE "backup” (id=830002514208) -
ActivityThread.main(String[]) line: 4363 ol m ’
Method.invokeNative(Object, Object[], Class, Class], Class, int, boolean line: not available [native method]
Method.invoke(Object, Object... line: 521

ZygotelnitSMethodAndArgsCaller.run{ line: 860

Zygotelnitmain(String[]) line: 618 -
NativeStart.main(Stringl]) line: not available [native method] « |l ’

[ & lava &0 Team Synchr... [ SVN Reposit.. 2

) Braakpomtﬂ

vlwlvlv|vlw

com. example . helloandroid.HelloAndroid@44e87288 -

[1] HelloAndroid java 57 =g Qutline 5 A8 e ¥ "0

lpackage com.example.helloandroid; - #  com.example.helloandroid
2 “=  import declarations
3import android.app.Activity; @ HelloAndroid

<import android.os.Bundle; @« onCreate(Bundle) : void
5

&

7public class HelloAndroid extends Activity {

/** Called when the activity is first created. */

@override

public void onCreate (Bundle savedInstanceState) {
super.onCreate (savedInstanceState) ;
this.setContentView (R.layout.main) ;

B
10

« b

Bl Console &7 2 Tasks|
Android

[2010-03-12 02:36:45 - HelloAndroid]Android Launch! -
[2010-03-12 02: - HelloAndroid]adb is running normally.

[2010-03-12 02: - HelloAndroid] Performing com.example.helloandroid.HelloBndroid activity launch

[2010-03-12 02: - HelloAndroid]Automatic Target Mode: Preferred AVD 'test' is available on emulator 'emulator-5554'

[2010-03-12 02: - HelloAndroid]Application already deploved. No need to reinstall.

[2010-03-12 02: - HelloAndroid]Starting activity com.example.helloandroid.HelloAndroid on device

[2010-03-12 02: - HelloAndroid]ActivityManager: Starting: Intent { cmp=com.example.helloandroid/.Hellolndroid }

[2010-03-12 02: - HelloAndroid]Attempting to connect debugger to 'com.example.helloandroid' on port 8621 E]

BE|#B-ri-=0
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Dalvik Debug Monitor

R File Explorer
R Bildschirmfoto
R Prozessanzeige (Basiert auf: ps —x)

R Zugrift auf logcat / dumpsys / dumpstate aus dem Ul
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R Einfiihrung
R Bestandteile des SDKs
R Debugging
3 Syslog Anzeigen
3 The Monkey
©3 Android Debug Bridge
3 Dalvik Debug Monitor

3 Performance

R NDK
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Performance d. Alignment

R Tool: Zipalign

$ zipalign [-f] [-v] [-c] <Alignment> Input.apk Output.apk

©3 Alignment muss immer 4 sein!
R bei 32bitWortern (die es in Dalvik sind)

R Aus Eclipse automatisch

R Warum?

O3 Direkter Zugriff mit mmap()
3 Weniger RAM
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Performance

&R Mehrere Moglichkeiten

3 ‘Tracing

O3 TimingLogger
R MethodTracing

3 Via Traceview

3 Laufzeit der einzelnen Methoden betrachten
R Timinglogger

3 Via logcat

3 Erzeugt Meldungen im ,base” log
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Performance

&R MethodTracing

©3 Start des Tracings (z.B. Programmstart)

Debug.startMethod Tracing(“<Name>");

3 Explizites Beenden des Tracings
Debug.stopMethod Tracing();

Mame Incl %
B 0 (toplevel 100.0%
I 1 android/os/Handler.dispatchMessage (Landroid fos/Message;)V 96.0%
I 2 android fview/ViewRoot.handleMessage (Landroid jos/Message; )V 71.7%

3 android /widget/ListView.makeAnd AddView (IZIZ)Landroid fview View; 70.5%
4 android /widget/AbsListView.trackMotionScroll (IDV 52.5%
5 android /widget/ListView. fillGap (Z)V 52.2%
B 5 android /widget/AbsListView.obtainView (Landroid /view/View: 52.2%

7 I Adapter.getView (ILa  52.1%
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Performance

R Timinglogger
3 Erzeugt Meldungen unter Topic "TopicLog Tag”

TiminglLogger timings = new TimingLogger("TopicLogTag","preparePicturesFromList");
<zu_loggender_Code>
timings.dumpToLog();

adsplits(,,<Label>)

3 Bessere Unterteilung mit

R Logeat: | ¢ 5db logcat -v time TopicLogTag:V *:E

D/TopicLogTag(14857) : preparePicturesFromlList: begin
D/TopicLogTag(14857): preparePicturesFromList: 1999 ms, creating picture object
D/TopicLogTag(14857): preparePicturesFromList: 712 ms, generating thumbnails
D/TopiclogTag(14857): preparePicturesFromList: end, 2711 ms
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Performance

R Testen der Geriteleistung

3 Langsame Hardware / Langsamer Emulator

R Linpack fir Android
3 Im Android Market oder im Netz

3 Android 2.1 auf Core2Duo @ 2,4GHz = 1,131 Mflops
&R Ubertaktetes Droid bis zu 25Mflops @1,3GHz
R Nexus One 8-10Mflops
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Inhalt

R Einfiihrung
R Bestandteile des SDKs
&R Debugging
3 Syslog Anzeigen
3 The Monkey
©3 Android Debug Bridge
3 Dalvik Debug Monitor

3 Performance

R NDK
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NDK

R Native Developement Kit
3 Grundsitzlich eine Toolchain die ARM-Bytecode erzeugt

©3 Erlaubt Teile der Anwendung in ,native” Code zu bauen
R Keine kompletten Anwendungen
R Unterstiitzt C / C++
&R Nicht unbedingt schneller, aber komplexer

R Wiederbenutzung von bestehendem

R Enthilt OpenGL ES Bibliotheken
@3 Und weitere
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Zusammentassung

R Installation und grundlegende Konfiguration
&R Ubersicht tiber die meisten Tools
3 Emulator
3 Avds erstellen
&R Ubersicht iiber die Debugging Funktionen
©3 DDM - Dalvik Debug Monitor
©3 ADB — Android Debug Brindge
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